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This is a legal agreement between you, the user, and CardReaderFactory (we, 
our, us). This agreement covers all hardware and software that is distributed with our 
products, for which there is no separate license agreement.

By opening or breaking the seal of the package, using our products, installing or 
downloading the software, or using our products and/or the software that has been 
preloaded or is embedded in our products, you agree to be bound by the terms of this 
agreement.

TO THE MAXIMUM EXTENT PERMITTED BY THE APPLICABLE LAW, 
UNDER NO CIRCUMSTANCES SHALL CARDREADERFACTORY OR ANY OF ITS 
LICENSORS BE RESPONSIBLE FOR ANY DATA TRANSFERRED TO AND FROM 
OUR PRODUCTS, FOR ITS USAGE, FOR ANY LOSS OF DATA OR INCOME OR ANY 
SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
HOWSOEVER CAUSED.

You must understand that you, and not us, is responsible for all data transferred 
to and from our products and for their usage. We are not responsible for anything you do 
with our products. You must not use our products in any way that will, or is likely to 
breach any law. You must not use our products for any fraudulent purposes, or in 
connection with a criminal offence or other unlawful activity. 

You must not use our products to obtain any information without the owner's 
knowledge or approval. You must not send, use or reuse any material that is illegal, 
offensive, abusive, indecent, defamatory, obscene or menacing; or in breach of 
copyright, trademark, confidence, privacy or any other right; or is otherwise injurious to 
third parties; or objectionable; or which consists of or contains software viruses, political 
campaigning, commercial solicitation, chain letters, mass mailings or any "spam". You 
and your applications of our products must not cause annoyance, inconvenience or 
needless anxiety. You will safeguard the use and distribution of our products and make 
any effort to prevent illegal use from occurring.

This license is effective until terminated. It will terminate upon the conditions set 
forth above or if you fail to comply with any of its terms. Upon termination, you agree that 
the Hardware, Software and accompanying materials, and all copies thereof, will be 
destroyed. This agreement is governed by the laws of United Kingdom, People's 
Republic of China, Hong Kong and British Virgin Islands.

Each provision of this agreement is severable. If a provision is found to be 
unenforceable, this finding does not affect the enforceability of the remaining 
provisions, terms, or conditions of this agreement. 

This agreement is binding on successors and assigns. 
You agree and we agree to waive, to the maximum extent permitted by law, any 

right to a jury trial with respect to any dispute and all disputes will be resolved through 
binding arbitration. Because this waiver may not be effective in some jurisdictions, this 
waiver may not apply to you. You acknowledge that you have read this agreement, that 
you understand it, that you agree to be bound by its terms, and that this is the complete 
and exclusive statement of the agreement between you and us regarding the Hardware 
and Software.

Terms and Conditions - General
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 We warrant that all of our products are free from defects in material and 
workmanship under normal use and service for a period of sixty (60) days for OEM 
products and one (1) year for all other products unless otherwise stated. This period is 
counted from the date of the shipment. Our option, any device returned for warranty 
work and found to be defective by us.

 To repair the device under warranty, the customer has to complete this form first: 
http://www.cardreaderfactory.com/shop/repairs.html. We will then e-mail an RMA 
number, the shipping address and instructions. The product will then have to be 
returned by the customer to the specified address (to our factory or facility). We will, 
without charge, repair or replace at our option, any product returned for warranty work 
and found to be defective by us.

 If we will find that the returned product is defective and falls within the terms of this 
warranty, we will ship free of charge the product, back to the customer with a postal or 
courier service at our own discretion. We will also credit to the customer's account with 
us, the amount he/she paid for shipping, but not exceeding 50USD. This credit can only 
be used for paying other orders with us and has no other cash value.

 This warranty will not apply to any of our products which should have been:
 Repaired or altered (except by us)
 Tampered with or the seal case has been broken (if applicable)
 Poured onto glue or any other kind of liquids / substances
 Subjected to misuse, negligence, or accident.

 In no case shall our liability exceed the purchase price. The mentioned provisions 
do not extend the original warranty period of any product which either been repaired or 
replaced by us. The user is solely responsible for determining if the product is usable in 
his or her application.

 We will not cover, under any circumstances, any customs or customs processing 
charges. Any such charges will be billed to the customer.

 If a product has been returned for warranty repair and it is found to be in working 
order, we will charge a revision fee (usually 80 USD unless otherwise stated) and the 
shipping fees to return it back to the customer; in this case we will not cover the 
customer's shipping fees.

Our details

 CardReaderFactory is a trading name. For company information details, please 
read:

http://www.cardreaderfactory.com/shop/terms-and-conditions.html 
http://www.cardreaderfactory.com/shop/about-us.html

Terms and Conditions - Warranty



MSRv007 OEM portable card reader.

MSRv009 OEM portable card reader.
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Parts identification

MSRv007

MSRv009

MSRv010

MSRv010 OEM portable  card reader.
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3.7 Volt, 40mA, Li-Ion rechargeable 

battery.

Your MSRvXXX can run 16 days on this 

battery if it is fully charged.

Rechargable battery

This plastic rail has a 3 track low profile 

read head which can be used to read up 

to 1,000,000 cards. 

The cable required to communicate with 

the MSRvXXX from your PC.

The cable seems like a standard mobile 

phone cable but it contains a USB to 

Serial Port converter and a custom pin 

layout therefore, it cannot be replaced by 

any  o the r  cab le  made  by  o the r 

manufacturers. 

Using other cables with your MSRvXXX 

will damage it and void its warranty. 
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Plastic rail

USB data cable

CARD READER FACTORY

MAGNETIC STRIPE READERSMSRv007 | MSRv009 | MSRv010



USB charging cable

During the charging a led on the cable will turn on to indicate that it is charging the 

battery and will turn off when the battery is fully charged. 

The led on the cable will blink if there is any problem when charging.

This cable is used to charge the battery of the MSRvXXX devices using 

any USB port. This cable cannot be used to connect to the reader using 

CRFSuite.  It only charges the battery.

This cable charges the battery until it is fully 

charged. It will automatically stop when 

required. It does not work on a timer 

therefore will not damage your battery. 

To use it, plug one part of the cable into any 

USB port from your computer and the other 
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Software Installation

1. Install the drivers and software
The software for MSRvXXX has been designed and tested on Windows XP and 

Windows 7 (32 and 64bit). We do not guarantee or support its usage on any other 

operating system. 

Insert the CD into your CD-Rom.

NOTE: On each Windows computer the CD-ROM has attributed a letter. In this 

manual we will use as example E:\ as the CD-ROM drive letter. 

It might vary on each computer. You can find out the letter of your CDROM by 

clicking on “My Computer” icon.

A window with our “Terms and conditions” should automatically pop out. If your 

computer does not show this window, double click on E: (your CD-ROM drive). Read 

our “Terms and conditions” carefully. After accepting our “Terms and conditions”, the 

interface will guide you through the installation process, offering drivers, user manuals 

for all our products and useful video tutorials about how to use and samples.

Here we present you the steps:

Step 1 - Terms and conditions
By using our software and hardware you agree  to be bound by our “Terms and 

conditions” which you can read at the beginning of this manual. Please make sure that 

you have read and agreed with them. You can also read them by inserting the CD into 

your CD-ROM drive. If you do not agree, please return the reader with all its accessories 

to us for a full refund.

Image 1: Terms and conditions
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Step 2 (optional) - Windows setup
a) Some documents might require your computer to be able to display PDF files. If your 

computer is not able to display them, please install Foxit Reader from our cd. You can 

install it by clicking the Install Fox Reader button.

b) If you are running Windows XP and Vista, you might need to install .NET 2.0 

framework. If it isn't already installed, CRFSuiteSetup will try to download it from the 

internet. You can skip the download by installing the .NET framework from our CD. 

Please click on Install .NET Framework  and chose the version for your PC (32 bit or 64 

bit).

.NET Framework 2.0 SP2 for x86 machines (for 32 bits system installation)

.NET Framework 2.0 SP2 for x64 machines (for 64 bits system installation)

If the installation fails, you will need to cleanup your computer of the failed .NET 2.0 

Framework using the software downloaded by clicking the button clean-up. Only after 

your computer has been cleaned, you can attempt to reinstall the.NET Framework.

Step 3 - Drivers installation

You have to install the driver for USB cable in order to access your 

reader. Select your device from our user friendly interface. It will guide 

you through the whole process. You need to do this only once on any 

computer you use. Without a successful install of the drivers, the 

software will not detect your reader. Please click the button Install 

driver for USB data cable  from the menu (Image 3), to successfully install the driver.
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Image 2: Chose your device
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Step 4 - Install the MSR software (CRFSuite)

CRFSuite is the software that accesses, configures, downloads and decodes the data 

from your reader. Please click the button Install CRFSuite from the CD’s User 

interface.

If the installer needs to download the .NET 2.0 Framework and you do not have an 

internet connection, please refer to Step 2 of this manual.

If CRFSuite does not start and shows the message "The application failed to initialize 

properly (0xc0000135)." it means that you have not installed .NET 2.0 Framework 

and you need to repeat Step 2.

To watch a demonstration of CRFSuite, please view our video tutorial on How to use , 

by selecting it from your Cd’s menu, or refer to this manual.

If for some reason you cannot use the CD-ROM drive (eg. you don't have a CD drive on 

your computer) you can download the software from this web address:

http://www.cardreaderfactory.com/download.html

Image 3: Install your software
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Software usage

2. Using the software
The software to use with our products (the program that downloads and decodes data 

from any MSRv xxxxxx) is CRFSuite.

2.1 Step 1 - Connect to the reader:

CRFSuite is designed to work with all our card readers

therefore it has more options than MSRvXXX needs. 

Please double click on the CRFSuite icon on your 

desktop to open CRFSuite (Image 4).

As your reader is connected through USB, please 

select the USB radio button. 

After selecting the USB radio button, CRFSuite will

detect all USB Serial ports found on your computer. 

They will be presented in the combo box below the 

radio buttons, where you can choose which one to 

connect through. If you have only one MSRvXXX USB 

cable connected to your computer, there should be 

only one entry in the list. However, if you have multiple 

entries, select each one until you find the correct USB 

Serial port. 

If there will be no port showing in the combo box you 

can use the radio buttons “All ports” or “All ports (if 

everything else fails)” and the program will display in 

the combo box any communication port found on your 

computer.

After selecting the desired port in combo box, press

“Connect”. If you receive a message like “Access to 

the ‘COMx' is denied” and you are sure that this is the 

correct port, press Connect several times until you 

receive the message “Connected; authentification 

required’’. If the problem persists, please remove the 

USB cable from your computer and plug it back in.  

This should fix the access denied issue.

At this point, CRFSuite has connected to the MSRvXXX and will ask for a password. The 

default one is “1234". You will be able to change it later. Type in the password and press 

Log In (Image 5).  If you've logged in successfully, a window will pop up asking if you 

want to change the default password.
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Image 4: CRFSuite startup

Image 5: Connect and Log In
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2.2 Device Info box
On the upper area of the window there is the "Device 

Info" box. In here you can see the status of your 

device. The information displayed includes the date 

and time of the device, the number of swipes in 

memory, the number of swipes in device's life time and 

the memory used/available.

You can also read more information from each field by 

holding your mouse  pointer over this field for a few 

seconds.

The State field should be always “OK”. If it isn't, there's 

a fault with your device. CRFSuite will display instead 

of OK a short description of the fault.  To refresh the 

data from this box, clicking anywhere inside it. 

2.2.1 Commands

Download - downloads the data from the device.

You will be prompted to choose the name of the file. All 

the files downloaded from the reader are in .CRF 

format which is encrypted.

Erase - erases the content of the device. During the 

erase, the device’s led will blink from time to time which 

indicates that it is erasing the memory.

Warning: Once this button is pressed, the 

data will be permanently erased and there 

will be no way to recover it from your device.

Decode - opens the decode window which allows you 

to see, modify, print and save the downloaded data. If you have not downloaded 

anything from your reader, it will ask for the file that you want to decode. This operation 

will be discussed in next chapter.

Reboot - will reinitialize your device as if the power was cut. Normally you will not use 

this feature. Please note that this feature is disabled for demo devices.

Image 6: Device Info box

Image 7: Commands box
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Log Out - It logs you out from the device. If you do not log out, the next time you (or 

someone else) who connects to the device will not be asked for authentication. For 

this reason, we strongly recommend that you log out or close CRFSuite before 

disconnecting the device from the computer.

Upgrade - This button is only displayed for demo versions and enables full functionality 

of your device. In order to upgrade your device you need to purchase from us an 

upgrade password. This password you will have to paste (CTRL-V) or type in the 

password boxes displayed after clicking on Upgrade” button. Once the upgrading is 

done, this button will disappear and the name of the device will change from “Demo 

Card Reader” into “Card Reader”.  Please do not try random passwords as you will 

block the device and you will be unable to use the device at all for  a limited period of 

time. All blocked devices will display at any connection 

attempt a warning windows letting the user know for how 

long the device will remain in this state.

Upgrade and change key: After log in , a window will 

pop up, showing that your device is a “Demo Card 

Reader” (Image 8). To upgrade your demo device to full 

functionality, you need to purchase the upgrade key from 

us. You can purchase it from this link:

http://www.cardreaderfactory.com/shop/upgrade-

codes.html

Once you received the upgrade password, you can 

proceed upgrading by clicking the Upgrade button at 

the bottom of the window (Image 9).

 Type in or paste the upgrade (key) password received 

via e-mail, in the text bar and click OK and then Yes to 

finish the upgrading. 

At this point, you can see from the CRFSuite window 

that the Name of your device is changed to Card 

Reader and the Upgrade button is no longer present 

and message “Upgrading succeeded” will be seen at 

the bottom of the window.

Image 8: Upgrade

Image 9: Key button
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Clock -  When you power on the device, it starts from 00:00:00 1/1/1970 GMT. You can 

synchronize the device date and time with your local time zone by pressing this button. 

You will be prompted with a  text box like in Image 10.

 Sync - will synchronise the device clock with the computer’s clock. All the values in 

the additional fields are ignored. 

 Ok - will synchronise the clock with the values specified in the fields above.

 Cancel - the clock on the device will be left unchanged and you will be returned to 

the Step 2.

Password - This option changes the password for your device (Image 11). 

Warning: If you forget the new password you will not be able to access the 

device any more and we won’t be able to help you.

 Ok - will change the password with the one requested.

 Cancel - will not change the password and you will be returned to Step 2.

 Show pass – will show the password you entered.

Image 10: Change Clock Image 11: Change password
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2.2.2 Menus and its features
On the Menu Bar of the CRFSuite window, there are three menus: File, Device and 

Help. 

File - it will get you a drop down list (Image 12) with following Sub Menus:

Open... - will let you choose and open .txt 

and .crf files.

Device Manager - You can use Device 

Manager to view a list with present hardware 

devices on your computer and set properties 

for each device.

Install CRFSuite to flash drive... - You can 

browse and select a folder or a removable 

drive where you want CRFSuite to be 

installed. This feature will not install 

CRFSuite on your computer. You will have to 

run the program by clicking on the .exe file 

from the folder where you choose to install 

CRFSuite with this option.

Preferences - Will pop up the Preferences 

window. This allows you to configure the 

behaviour of CRFSuite.

Exit - Closes CRFSuite and any .crf files 

open.

The Preferences pop window has 3 tabs: 

Settings, Keys and OEM - which are 

explained below.

Settings – (image 13) – allows you to 

associate CRFSuite software with .crf file 

format. Once associated you can double 

click on any file with .crf extension and CRFSuite will automatically open the file for you. 

Here you can also enable or disable the pop up dialogs which ask you:

-  if you want to change the "1234" login password;

-  if you want to open the file immediately after the download;

Image 13: Preferences

Image 14: Edit keys

Image 12: File menu
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Keys – (Image 14) - You can edit stored encryption keys by ticking the check box of “Edit 

keys”. Your key will be stored here after you tick the check box of Remember Key in pop 

up window labeled “Enter Key” when you decode data or open a .crf file (this isalso 

discussed in Decode the data part). Now you can edit or erase your keys in the text box. 

Click Apply to save your changes. Click Cancel to discard changes and exit the 

preferences. Click OK to confirm changes and exit. 

OEM – (Image 15) -  If you point your mouse over the 

check box and label “Remove OEM features” a 

warning message will pop up. Please read it carefully 

before you decide to remove the OEM features. 

Ticking check box labeled “Remove OEM features” 

will allow you to rename the CRFSuite with a  new title 

of your choice. Click Apply to save the changes. Click 

OK to save changes and exit. Click Cancel to discard 

changes and exit.

Device – will get a drop down list with Sub 

Menus as shown in Image 16.

Refresh info – Click this Sub Menu to 

refresh the info in Device Info box. You can 

also refresh the Device Info box by clicking 

anywhere inside the Main Window. If  none 

of the parameters change it is because the 

in fo rmat ion  about  your  reader  i s 

unchanged; however with each refresh  the 

device clock parameter should be updated.

Image 15: Change OEM feature

Image 16: Device menu
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New mode and Old mode

Since build number 6xxx, our MSR device have 2 read modes:

• The old mode was used in all readers with build numbers below 6000

• The new mode is the default read mode in all readers with the build number

above 6xxx.

Difference between the two modes:

• The new mode can read 704 bits while the old mode was able to read 608 bits. As both 

specifications are above the magnetic cards standard, the advantage is noticeable only 

if you are using a customized card format.

• The new mode allows us to check if there is something wrong with the head.

NOTE: If your device works correctly in the new mode, it will also work in the 

old mode. In order to switch from one read mode to another, you just need to 

click on New mode or Old mode.

Firmware update – You can check your firmware version in the Device Info box. By 

clicking Firmware update (from file), you will be asked to select an .aes file extension 

format. If you click Firmware update (from internet) the software will connect to our 

server using an Internet connection and update your firmware automatically.

Help – This menu and its Sub Menus (Image 17) allows you to access help files and 

tutorials, report a bug, check for CRFSuite updates and check your current software 

version by clicking About..

Image 17: Help menu Image 18: Build number
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2.3  Obtain your decryption key
The data downloaded from your card reader is encrypted with a military grade 

encryption (Rijndael-128). In order to decrypt the file, you need to have a key which is 

unique for each reader.

We never ship the key together with the reader. You need to confirm us that you have 

received the reader and we will send you the key. In order to obtain the key, you need to 

write an email to support@cardreaderfactory.com and ask us for the key. 

You need to include into your email the build number of your device. This number is 

displayed in the Device Info box (please observe the red rectangle from Image 18).

We will only send the key to the email that has been used to place the order so we can 

make sure that nobody else can obtain your own private key from us. 

Please take good care of your key.

Note: We will never disclose your key to anybody else (unless the law  

requires us to). To protect your privacy please change your key!

Along with the upgrade key we emailed to you, 

there is also the master password in 4 numbers 

we provided. 

This is the second password besides the default 

Press the Key button, you will get a window as 

Image 19. Then, you can change your key in the 

Change key box by entering your new key in the 

Enter key text bar and enter the new key again in 

the Verify key text bar. 

Click OK button to save your change and exit the 

Change key session. 

Click Cancel to discard your change and exit the Change key session. 

If the new key is invalid, a popped-out window will ask you if you would like to 

generate a random key. 

Image 19: Change key
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If you agree and press Yes in the dialog window, then the CRFSuite will fill in the text 

boxes with the new randomly generated key and will also write it into clipboard. At 

this point you can open any text editor application (notepad, word etc.) and press 

CTRL-V to paste the new key.

2.4  View and edit the data

If you have just downloaded a file from the reader, 

once you press the Decode button you will be 

presented with the window from Image 20.

To decode the file, you just need to paste (or type) our 

private key into the text box and press Accept.

If you want to skip this dialog for all future files 

encrypted with this key, you can ask CRFSuite to remember your key by clicking 

"Remember Key". Your key will be stored in File/Preferences/Keys and you can view, 

edit or erase it there. Enter Key window will only appear when open a .crf file that is 

encoded with an unknown key.

Note: Please note that this will might be security risk if someone else can get 

access to your computer. 

There is also a check box of CBC in the Change key area. Note the CBC check box. It 

tells the reader that it can use the CBC (cipher block chaining) encryption mode which is 

stronger than the old encryption mode. If you choose to use this mode you will only be 

able to read the data with CRFSuite 3.1 or higher.

Image 20: Enter key
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2.4.1 Open a .CRF file
In the upper menu, select File and then Open.... A new window will open which will allow 

you to select the “.crf” file that you want to decode. After you’ve selected the file, you will 

be asked for the decrypt key (the same window shown in the previous paragraph). All 

the files downloaded from the MSRvXXX (.crf) are encrypted. The contents of these files 

cannot be accessed without a key therefore you will be asked for one each time you 

want to open these files. The key is 32 characters long and contains only numbers and 

letters from a to f. The software does not make any difference between upper case (e.g 

’A’) and lower case (e.g ‘a’).

2.4.2 View the data
If the key is OK, the program will decrypt the data and display it in the text box in the

window as Image 21 shows. From now on, you can edit the file and arrange the data as 

you see fit.

As you can see from the window, the text box is generally divided into two sections. The 

upper half area shows the most reliable decrypted data according to the settings and 

decoding of our Decode program. If you click or go to any cell of any Track column, you 

will see in the lower half area of the window all the variants of that decrypted data as well 

as the swipe direction and reliable rate relates to it. You can review all the variants and 

choose the one that you think most fit by clicking or going to that cell of variant. 

This will change the data in the Track field. To save the changes you made, click File, 

then click Save or Save as..

USER MANUAL 20

Image 21: Decode data
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2.4.3 Saving the data

CRFSuite can save CRF, Text files and CSV files.

A text file is the human readable information and is 

NOT encrypted. 

The data shown into the text file is the best guessed 

variant by our software. All other variants are not 

saved therefore they are lost. 

A CSV file is "comma separated values" which can 

be imported by spreadsheet software such as Excel 

or Open Office.

A CRF file is generated by CRFSuite which contains 

the decrypted data of the cards. A CRF file can only 

be opened by CRFSuite software.

To save after you edited and arranged the 'CRF' file , select File and then Save to the file 

you opened, or Save as... to a new named 'CRF' file as Image 22 shows.

You can also save the data in the file you opened and edited in other types of files as text 

document .txt and csv (shown in spreadsheet program) by selecting File and then 

Export as .txt or .csv like Image 22 shows.

Warning: Do not use the text files as 

'CRF' replacement!

The text files do not contain important informations 

(variants, encoding, colors etc.). If you still need this 

information please make sure that you also save the

document in CRF format.

Above warning information will also appear in a dialog window when you successfully 

exported your data into text files as shown in Image 23. And you can see the detailed 

explanation of the warning by clicking the 'Show details' icon on the pop-out Export text 

file window.
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Image 22: File menu in Decode window

Image 23: Warning for text files
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2.4.4 Edit the data

You can use the Edit menu in the upper Decode program window (Image 24) to edit and 

arrange your data by clicking the Edit and the items on the menu.

Undo – Reverses the last command or the last entry you input.

Redo – Reverses the action of the last Undo command.

Cut - Removes and copies the selection to the clipboard.

Copy - Copies the selection to the clipboard.

Paste - Inserts the contents of the clipboard at the location of the cursor, and replaces 

any selected text.

Delete - Removes the selection.

Find...- Searches and highlights the data you want in 

the file.

Input the data that you want to search in the text bar 

and click the Find Next button (Image 25 ), then the 

data you want to search will be highlighted in the file. 

Click the Find Next button, then the next occurrence will be highlighted.
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Image 24: Edit menu in Decode window

Image 25: Find function
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 You can keep pressing the Find Next button until the search has reached to the end 

of document. 

You will be informed by a dialog window when you have reached the end. If the data you 

want to search does not exist in the document, a window will appear to  warn you.

You can set the Find direction as Up or Down by clicking either of them. 

To match case when searching, click the Match case box. Click Cancel to exit Find 

command and setting.

Find next - click this item on the Edit menu after you set your Find..., then the data you 

want can be highlighted and shown in the window. The shortcut for this function is F3 

key as you can see in the menu.

Select All - click this item on the Edit menu, all the data in your document will be 

selected. Selecting data is useful to perform actions like cut/copy/paste/delete which 

are also available from the Edit menu.

EditMode - This menu has a submenu which includes 3 modes: “Edit on Enter”, “Edit on 

F2” and “Text Edit”. These options will change the behaviour of the editor and you 

should choose the behaviour that you find it easier to work with.

“Edit on Enter” – in order to edit a cell you will need to press Enter. You will be able to 

navigate the cells with the arrow keys from your keyboard.

“Edit on F2” - in order to edit a cell you will need to press F2. You will be able to navigate 

the cells with the arrow keys from your keyboard.

“Text Edit” - this will make the editor disregard the cells and behave like a normal text 

editor. You will be able to navigate with a cursor through all the characters.

2.4.4.1 View setting and toolbar
Click View in the upper window, you can go to the View menu as shown in Image 23. 

This menu contains commands for controlling the on-screen display of  the document.

Fields Toolbar - Shows or hides the field toolbars including Direction, Time, Track1, 

Track2, Track3, Settings and Resize Columns.

•Direction - shows or hides the Direction information in the document.
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•Time - shows or hides the Time information in the document.

•Track1 - shows or hides the Track1 information in the document.

•Track2 - shows or hides the Track2 information in the document.

•Track3 - shows or hides the Track3 information in the document.

•Settings - shows a window for you to do the format setting for your file.

•Resize Columns - goes back to the original column size of your file.

Quick Settings Toolbar - Shows or hides the quick settings toolbar including 

DecodeMethod and Format.

•Decode Method - click on the text toolbar, choose any command to display the 

decoded data. Options are 'Show everything (including the errors)', 'Show only the valid 

data,hide the error' and Show the best guess’.

•Format - shows the format of the decoded data in the file. Put mouse pointer on each of 

the two text toolbars for detailed explanation.

Decode Toolbar - Shows or hides the decoding settings including Grouping interval, 

Align and Filter.

•Grouping interval - cards with a time difference smaller than the number shown in this 

box will be colored in the file.

•Align - number in the box is the number of minimum common chars to align cards.

•Filter - input in the text toolbar the data you want to search, then entries contain in the 

text will be shown.
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Image 26: View menu in Decode window
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2.4.4.2 Tools

Image 27 shows the Tools menu in the window. There are three functions on this menu 

as below.

Delete empty card - this command key enables you to remove empty card data from 

you file. A small window will appear when you click this item on the menu. The popped-

out window asks you to input a number to perform your command. Cards with all tracks 

with a number of characters equal or less than the number you input will be considered 

as empty. After input the number, the window will show you the numbers of cards found. 

Click Accept, found cards will be deleted. Click Cancel, you will exit from this command.

Show key - click this item, a window will show you your current key information for

decoding. Meanwhile, your key information has been copied on the clipboard.

Settings - This feature allows you to preset your decode setting. Click the Tools menu, 

then Settings, there will appear a new window of Decode setting as Image 28 shows. 

You can also click the Settings button in the Fields Toolbar on the upper left of the 

window to go to the setting window (see the red rectangle in Image 28 for the Settings 

button). On the Decode Settings, there are below features.

•Decoder - you can choose either Advanced or Simple mode. Advanced mode 

recommended as it is in grid mode which has more features. Simple mode is test mode.
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Image 27: Tools menu in Decode window
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•Display settings - you can set the data display here by choosing from the option menu 

in this area.

You can set the grouping interval by minutes, seconds or miliseconds. In the “Align by” 

text bar, you can input a number which is the number of minimum common chars to 

align cards. The swipe direction can be shown or hiden in the file if you click the check 

box of Show Direction. You can also click Show time to show or hide the time 

information in the file. Time can be shown in date/month/year/hour/minute/second or 

other mode according to the option you chose by clicking submenu bar besides the 

“Show time”.

•Decoding parameters - you can set the decode method by choosing from the options 

listed here.

The Decode method includes three options as “Show everything (including the errors), 

“Show only the valid data, hide the errors” and “Show the best guess”. You can choose 

one mode you see fit. We recommend you to choose “Show the best guess” and the 

next feature “Use smart decoding”. Click in the box before Track1 will enable the 

window to shows or hides that track. Same with Track 2 and Track 3.  The data shown in 

each track is decided by the standard you choose at the bottom of this area.

 You can choose from 'ISO 7811(IATA + ABA + THRIFT)' to 'Custom format'. For the 

BPC and Start information for each track, please refer back to Format on Quick Settings 

Toolbar.

•Click the box at the bottom to show or not show this window when opening a file.

•Click OK to save your settings and exit. Click Cancel to discard your last settings and 

exit.
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Image 28: Decode setting
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2.4.4.3 Shortcut and function keys for Decode program

Ctrl+O : open a .crf file
Ctrl+S: save a .crf file
Ctrl+Z: undo
Ctrl+Y: redo
Ctrl+X: cut
Ctrl+C: copy

Ctrl+V: paste
Del: delete
Ctrl+F: find query
F3 : find next
Ctrl+A: select all
Ctrl+E: resize columns

MSRvXXX Signal codes

The reader shows light signals as a feedback for the user. 

Please find below the list with the meanings for these signals:

Normal operation:

Start Up - Blue LED (only) blinks twice rapidly (2x 25ms)

Read Card OK - Blue LED blinks once for 25 ms

Erasing Memory - Red LED turns on and off for an average of 1.5seconds intervals

Errors:

Card Read but not stored - Blue LED signals 5 times for 25ms; this signal is shown only 

by the demo version.

Other failures - on start up the Red LED will blink few times (not as normal). The error 

will be displayed by CRFSuite through a warning message as you log in. It will also be 

shown into the Status field.

Charging the battery

The reader is shipped with a rechargeable Li-Ion battery. When the battery runs out, it 

needs to be charged. We ship our card reader with a USB charging cable which you can 

connect to any powered USB port. The USB connector of charging cable is plugged into 

a powered USB port and the Micro USB connector of the charging cable it will be 

plugged into your MSRvXXX with the battery connected to it.

The cable charges the battery until it is fully charged and automatically stops. Charging 

time it is not controlled by timer therefore the charger will not damage your battery.
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Connections

The MSRvXXX is static sensitive therefore you need to handle it in a static free

environment.  This means that you need to wear at least an antistatic bracelet when

you touch the electronics. If you do not wear static protection gear you risk damaging the 

electrostatic circuit.

The reader requires at least 2.8Volts to work correctly and a maximum of 3.8volts.

Please read the card reader’s datasheet for complete information.

The wire connections to the battery and the head are shown in Images 29, 30, 31.

Note:

• While charging, the reader cannot be used to read any cards.

• This cable cannot be used to read the data from your MARvXXX.

You can also use any other 3.7V Li-Ion charger to charge the battery. 

Do not charge your battery more than 4.2 volts as it will blow up or catch fire. The red 

wire is LIVE (+) and the black wire is NUL (-).
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Image 29: MSRv007 Connections
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MSRv010

MSRv009

Image 30: MSRv010 Connections

Image 31: MSRv009 Connections
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Image 32: Head Connections

Head

Our mission is to understand and assess the needs of our customers and 

prospective customers and provide creative, responsive, timely and cost effective 

products by drawing upon our extensive experience and resources.

CardReaderFactory is committed to designing, manufacturing and delivering quality 

products, which exceed customer and regulatory requirements.

CardReaderFactory is a trading name .  Please consult 

www.cardreaderfactory.com for company information details.

About us
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Image 33: MSRv008 BLUETOOTH

Note: all sizes are in millimeters (mm).

Visit our website for more details.

sales@cardreaderfactory.com

support@cardreaderfactory.com

http://www.cardreaderfactory.com

Related products

Contact details



www.cardreaderfactory.com 

sales@cardreaderfactory.com
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